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Welcome to PwrSmart 

Power Management with PwrSmartTM 
PwrSmart is a simple, automated PC power management solution that centrally controls PC 
power settings and energy consumption. PwrSmart’s flexibility creates a self-monitoring, self-
maintaining, enterprise-wide PC power management solution that frees up IT staff, reduces 
energy costs, extends the life of IT assets and supports green initiatives. 

New Features in PwrSmart 3.0 
PwrSmart 3.0 provides enhanced, user-friendly functionality that extends IT administrator control 
over PC power management settings and energy management.  

 Simplified Console allows administrators to select from several EPA-recommended 
power schemes or to create and edit their own custom power schemes right in the 
Console. In addition, the energy savings calculator is now fully integrated into the 
Console.  

 PwrGroups™ (leveraging patented Smart Update technology) make it simple for IT 
administrators to dynamically target and group computer with similar power management 
requirements - standardizing and fine-tuning PC power management across an 
organization. PwrGroups can be based on Active Directory group membership, PC 
location, IP address ranges, hardware configuration, operating system language, time 
zones and many other parameters. Laptop and Desktop PwrGroups are built into 
included in the Console.  

 Customizable Power Schemes allow IT administrators to control and enforce multiple 
power profiles on the same system to accommodate different power settings depending 
on the time of day - any computer, any setting, any time.  

 Power management events can be scheduled to wake up, shut-down, hibernate 
or standby PCs after a pre-set period of inactivity or on a schedule.  

 Alternate Settings option lets IT administrators configure settings that differ from 
a scheme’s default settings for use during a specific time period each day.  

 Stay-awake period allows IT administrators to override power management 
actions in order to patch, update, scan, or back up PCs on a predetermined 
schedule. Stay-awake period can also be used to give users a block of time 
when they can remotely access their workstations before the PCs enter their 
scheduled hibernation period.  

 Software exclusions allow administrators to exempt PCs from scheduled power 
management events when specific applications are running to ensure that critical 
processes are not interrupted.  

 Dynamic energy savings calculator displays instant analysis of energy saved on the 
managed computers based on multiple criteria. The calculator also allows administrators 
to compare energy savings over two different time spans or different groups of computers 
and to project energy savings out to an annual basis. Multiple currencies are supported in 
the calculator. 

 Flexible reporting engine lets administrators create standard or customized reports. 

 Security Roles give administrators the flexibility to specify pre-defined roles and to 
customize permissions to allow or deny access to specific functions in the PwrSmart 
Console. 

New Boundary Technologies is an EPA ENERGY STAR Service and Product Provider partner. 
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Notes on the Documentation 
The PwrSmart documentation includes online Help and a Tutorial. This document is a portion of 
the PwrSmart Online Help (below) made available as a PDF. It focuses specifically on using the 
power management features. For additional information on the PwrSmart console, refer to the 
online documentation (installed with the PwrSmart console and available via its Help menu) or 
refer to the Prism Console User's Guide available on the New Boundary Technologies website. 

Tutorial 
Please review the Tutorial to gain a basic understanding of PwrSmart and to complete an 
exercise that leads you through the major features available with PwrSmart. The Tutorial is 
available through the Help menu in the console. 

Online Help 
When you select Help | PwrSmart Help or click the Help button on a dialog box, the online help 
is displayed. The online help provides information on all topics related to power management and 
the use of the PwrSmart console. 

Conventions Used in the Help and User Guides 
Buttons, fields,  
and options 

The names of individual fields or options on a pane or dialog box are in 
bold text. For example, Save button.  

Menus A vertical line (|) is used to designate an item on a menu. For example, 
File | Open refers to the Open option on the File menu. 

Tabs on a dialog box A vertical line (|) is used to designate specific tab on a dialog box. For 
example, Channel Properties | Licenses tab refers to the Licenses tab 
on the Channel Properties dialog box. 

Tabs on the main 
window 

The Console window is divided into two main panes—the tree view on 
the left and details pane on the right. A vertical line (|) is used to 
designate the combination of a specific tab in the tree view and a 
specific tab in the details pane.  

For example, Managed | Members tab refers to the Members tab in the 
details pane when the Managed tab is selected in the tree view. 

 

Contacting Technical Support 
If you are unable to locate answers to your questions within this help file, please use the following 
resources to receive assistance: 

Web site:       http://www.newboundary.com 
 
Here you will find the online New Boundary Technologies Support Forum, system 
requirements, knowledge base articles, and responses to frequently asked questions. 
The Support Forum is an interactive discussion tool that will bring you in touch with 
other users of New Boundary Technologies software.  

Phone:          612-379-1851 
or 800-747-4487 
 
Available 8:30 A.M. to 5:00 P.M. Central Time, Monday through Friday 
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PwrGroups: Dynamic Groups 
PwrGroups let you create customized rules to define groups based on very specific criteria and 
let you specify multiple values for evaluating and adding group members. The Console provides 
an Expert to help you with each step of the group set up or lets you type rules directly into an 
editor. PwrGroups can be as simple as matching a file name or as complex as identifying 
computers based on the presence or absence of multiple characteristics. 

PwrGroups are dynamic. If a computer no longer meets the criteria for group membership, it 
removes itself from the group. Likewise, if a new computer meeting the criteria for group 
membership is added to the Channel, it automatically adds itself to the PwrGroup.  

Adding a PwrGroup 
To set up a PwrGroup in the Channel: 

1. With the Managed tab open in the tree view, right-click on the PwrGroups branch in the 
tree view, then choose Create Group from the pop-up menu.  

2. In the Rule Expert: Choose a Type of PwrGroup dialog, select the option button for 
Subgroup Based on Rule. Click Next. 

Note: If an All Others group has been created, this dialog is skipped. Proceed to step 3.  

3. In the Rule Expert: Assemble a Rule Clause dialog box, define the rule by setting the value 
type, operator, and value. Click Next.  

Note: As you select options on this dialog box, the text of the rule is displayed in the Rule 
Text field. Use this information to confirm the content of the rule and learn how to 
type rules directly in the Rules Editor.  

4. In the Rule Expert: Rule Name dialog box, type a name for the group that will be defined by 
the rule you just created. Click Next. 

5. In the Edit Rule dialog box, check the syntax of the rule or add logical operators to expand 
the rule. Click Finish. 

Subgroups are populated in the Channel when a managed computer contacts the Channel 
Server.  

 

Creating an All Others Group 
An All Others group includes all of the computers in the Channel that are not members of another 
PwrGroup.  

1. With the Managed tab open in the tree view, right-click on the PwrGroups branch in the 
tree view, then choose Create Group from the pop-up menu.  

2. In the Rule Expert: Choose a Type of PwrGroup dialog, select the option button for All 
Others Group. Click Next. 

3. In the Rule Expert: Rule Name dialog box, enter a name for the new group or leave the 
default name—All Others. Click Next/Finish. 
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Editing an Existing PwrGroup Rule 
After creating a PwrGroup group, you can edit the rule to make changes in the value type, values, 
or operators. When you edit a rule, the group members are removed from the group and the 
group is re-populated, based on the new criteria. You can edit an existing PwrGroup group 
through the Group properties. 

1. Right click on the PwrGroup name in the tree view. 

2. Select Properties from the pop-up menu.  

3. In the Group Properties | General tab, click the Edit Rule button.  

4. In the Edit Rule dialog box, edit the rule directly in the Rule Text field. Or, click the 
Add Rule Expert button to add additional qualifiers to the rule.  

5. Click the Finish button to save your changes. 
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Power Management with PwrSmart 

Overview 
PwrSmart gives you control over when and how power is managed on your computers. It does 
this through Power Schemes. A power scheme defines three things:  

1. Power options control panel settings; 

2. Scheduled events (like shutdown); 

3. Software exclusions. 

Power Options 
The power options control panel settings define how much idle time must occur before the 
displays and disks turn off or the computer goes into a low power state (standby or hibernate). 
The computer's power scheme can be viewed in the Control Panel | Power Options. The 
following screenshot shows the settings from a laptop (desktop computers will not show battery 
settings): 

 
PwrSmart power schemes define specific, customizable power schemes that are enforced on 
target computers. For example, your company's power management practices might specify the 
following settings for a laptop when it is plugged in: 
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 Turn off monitor and hard disks after 10 minutes 

 System standby after 30 minutes 

After creating a power scheme to reflect these values and assigning the scheme to your 
company's computers, each computer's Control Panel | Power Options would look like this: 

 
If the end user then changes the scheme or any setting on the Control Panel | Power Options, 
PwrSmart will automatically revert it back to the settings defined by your power scheme. 

Scheduled Events 
PwrSmart power schemes can optionally include scheduled events. These can be used to force 
machines to shutdown or hibernate at a particular time, or to wake up at a particular time, or to 
stay awake for a specified period of time. 

Software Exclusions 
PwrSmart power schemes can optionally include software exclusions. A software exclusion 
defines a particular process which, if running on the target machine, will prevent that computer 
from suspending due to idleness. Scheduled Events are also disabled when an excluded process 
is running. 
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Using PwrSmart 
PwrSmart is easy and intuitive: 

1. Create groups - organizational groups or dynamic PwrGroup groups - to which you will 
assign power schemes. This activity is described in the section on groups. 

2. Create/use/modify schemes to reflect your corporate power management practices. 
PwrSmart comes pre-configured with several schemes that are ready to use. You can 
modify those schemes to match your needs, or you can create new schemes. 

3. Assign the schemes to computers and/or groups. There are several ways to assign 
schemes, the simplest being to select the target then double-click the scheme you want 
to assign to the target. 

4. View energy savings results to determine how much energy and money you are 
saving. Energy savings can be assessed on the Energy Savings tab. 

PwrSmart Power Schemes 
A PwrSmart Power Scheme consists of several facets: 

1. Name: Every scheme must have a unique name. When a scheme is active on a 
computer, this name will appear in the computer's Power Options Control Panel. 

2. Description: Optional description of the scheme. 

3. Priority: The relative priority among schemes. Every scheme has a unique priority value. 
Lower priority values take precedence over higher values. 

4. Power Options: These settings correspond to the Power Options Control Panel in 
Windows. These settings define what energy savings action to take after specified 
periods of idleness. 

5. Scheduled Events: Events are specific actions, such as wake on LAN, shutdown, and 
hibernate, that should occur at specified times independent of machine idleness. 

6. Software Exclusions: Exclusions define specific software executables which, if running, 
prevent the idleness events and scheduled events from occurring. 

1. Each of these facets is explained in more detail in the he Power Scheme Properites dialog 
section. 

Creating Power Schemes  
You can create a Power Scheme in several ways: 

 Press the Create Scheme icon  in the toolbar. 

 Select the Create Scheme menu item by: 

 selecting it from the Power Management menu; 

 right-clicking on the All Schemes node in the Power Schemes tree; 

 right-clicking beneath the All Schemes grid. 

Viewing and Editing Power Schemes 
To view a Power Scheme, select the Power Schemes tab and then select the Setup subtab. 

To view or edit a Power Scheme, open its Properties by: 

 press the Edit button on the Settings subtab under the Power Schemes tab. 
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 right-clicking on a scheme in the Power Schemes tree; 

 right-clicking on a scheme in the Schemes grid; 

 selecting a scheme and choosing Properties from the Edit menu. 

2. Once the Power Scheme Properties (or Create Power Scheme) dialog opens, you can easily 
modify its settings through the Power Scheme Properites dialog. 

Deleting Power Schemes 
3. To delete a scheme: 

1. Select the Power Schemes tab. 

2. In the All Schemes tree, select the Scheme to be deleted. 

3. Right-click and select Delete. You can also select Delete from the Edit menu. 

4. This will delete the scheme and all of its assignments to any computers or groups. 

Settings tab 
The Settings subtab shows the detailed settings for a scheme. If you select the All Schemes 
node, it shows summary information for all schemes (see All Schemes tab for more information).  

When a scheme is selected, the panel is split into four areas: general settings, Power Options, 
Scheduled Events, and Software Exclusions. To edit any aspects, press the corresponding Edit 
button to open the Scheme Properties dialog where changes can be made to the scheme. 
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Power Scheme Properties Dialog 

 
Use this dialog to define a Power Scheme.  

This dialog box is displayed when you create a new Power Scheme or modify an existing Power 
Scheme. It opens when you select: 

 The Create Scheme icon  in the toolbar. 

 Create Scheme menu item 

 from the Power Management menu; 

 by right-clicking on the All Schemes node in the Power Schemes tree; 

 by right-clicking beneath a Schemes grid. 

 Properties menu item for a selected scheme by: 

 right-clicking on a scheme in the Power Schemes tree; 

 right-clicking on a scheme in the Schemes grid; 

 selecting Properties  from the Edit menu. 
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General Settings 
The upper portion of this dialog allows you to specify the scheme's name, a description, and its 
priority. 

Name 
The name of the scheme. This name will appear in the end user's Power Options Control Panel 
as the current scheme name. This name is limited to 30 characters (this is enforced by the 
Windows operating system). 

Description 
An optional description of the scheme. 

Priority 
The scheme's priority. All schemes have a unique priority value. Only a single scheme can be 
active on a computer. However, a computer can belong to multiple groups. Therefore, several 
schemes may be assigned (either 0 or 1 directly, and any number indirectly, via groups). The 
priority dictates the "winner". A scheme with the lower priority number will be enforced rather than 
a scheme having higher priority value. 

When creating a new scheme, the priority will be set to a default priority value. You can adjust the 
priority setting up or down. When saved, the priority values of other schemes will be adjusted 
accordingly so that each scheme has a unique value.  

For example, if you create a new scheme whose default value is 3, and change it to 1, the other 2 
schemes will have their priority values changed from 1 and 2 to 2 and 3. 

Power Options Tab 
This tab defines settings that correspond to the Power Options Control Panel in Windows. 
PwrSmart will enforce the settings you specify independent of end user action. The values 
available are the same as in the control panel, with one exception: <user defined> (see below). 

The values specify how much system idle time must elapse before the energy savings action 
(e.g., turning off the monitor) occurs. Standby and hibernate both put the machine into a low 
energy state without affecting user sessions. Hibernate differs in that the user's session state is 
stored to disk instead of being kept in memory. While hibernate is more robust, it takes a little 
longer for a machine to come out of hibernation than from standby. 

<user defined> Value 
The special value "<user-defined>" means that PwrSmart permit will the end user to enter any 
value they choose for that parameter. It is a way of saying that the administrator "does not care" 
what value the user provides for a specific parameter. For example, a power scheme may allow 
laptop users to choose any settings they wish when they are running on battery power. 

Alternate Settings 
The lower panel of the Power Options tab allows you to specify alternate settings to use during a 
specific time period each day: 

Enable alternate settings: With this option selected, PwrSmart will enforce the 
alternate settings instead of the settings defined above. This might be used, for example, 
to allow more liberal settings during the day and more conservative settings at night, or for 
any reason at all. 

 Name: Provide a name for the alternate period. This name is shown on the 
Power Management | Settings tab. 

 Start time: This is the time when you want to switch to the alternate settings. 
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 Relative to: The time can be relative to the target machine, the current 
(console) machine, or GMT. 

 Duration: This is how long the alternate period should last. 

Enable alternate settings: With this option cleared, the power options defined in the 
upper panel are enforced 24 hours per day.  

Tip     The settings in either panel can be filled using the "quick fill" option available by right-
clicking in one of the 2 panels. The quick fill options include seeting all fields to user-
defined or Never, or to Windows default values or EPA recommended. 

Scheduled Events 
A scheduled event defines a particular action that should occur on the end user's machine and 
when it should occur. You can make a machine wake up, shutdown, standby, or stay awake. 

A scheme can have any number of events. To add an event, press Add. To remove an event, 
select one or more and press Remove.  

Events are defined by several settings: 

 Event Type:  The available event types are: 

 Wakeup: This is the Wake on LAN event. It can be used to wake up machines 
at a particular time. 

 Stay Awake: When this event occurs, the machine will stay awake for the 
specified duration independent of idleness. 

Note  The Stay Awake event automatically generates a preceding Wake on LAN event to 
ensure the target machines are up. 

 Shutdown: This causes the machine to power off. A warning message will be 
displayed to the end user 60 seconds prior to shutting down. 

 Standby/Hibernate: These actions causes the machine to suspend. As with 
Shutdown, a warning message will be displayed to the end user 60 seconds prior 
to entering a standby/hibernate state. 

Tip    There is no significant difference in energy savings between shutdown, hibernate, 
and standby. A computer in a shutdown state still consumes some energy, and 
consumes only slightly less energy than hibernate or standby. Unlike hibernate 
and standby, a shutdown destroys user sessions. And resuming from hibernate 
and standby is much faster than restarting a machine. Hence for energy savings, 
we recommend using hibernate and standby instead of shutdown. 

 Day: The day of the week when it should occur. This can be a particular day, or 
weekdays, weekends, or all days. 

 Time: When the event should occur. 

 Time Reference: The time can be relative to the target machine, the current (console) 
machine, or GMT. 

 Duration: For Stay Awake events, this defines how long the machine should stay awake. 
This setting is not used for the other event types. 

Software Exclusions 
Software exclusions are specific processes that, if running on the end user's machine, will de-
activate the power options and events. 
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A scheme can have any number of exclusions. To add an exclusion, press Add. Then enter the 
name of the executable, for example myprocess.exe. To remove an exclusion, select one or 
more and press Remove.  

Assigning Power Schemes 
It's easy to assign Power Schemes to computers or groups: 

1. Go to the Managed tab. 

2. Select the target computer or group. 

3. Select the All Schemes subtab. 

4. Select the desired scheme by doing one of the following: 

1. Use the Assign Scheme menu option (by right-clicking or using the Power 
Management menu) to open the Assign Scheme dialog. 

2. Double-click the scheme. 

3. Select the scheme and press the Assign button 

4. Select the scheme and press the   icon in the toolbar. 

When a computer is assigned a scheme, PwrSmart will apply that scheme on that computer. The 
computer's Power Options Control Panel will show the scheme name and the settings defined for 
that scheme. If the user changes the values, PwrSmart will set them back. 

Unassigning a Scheme 
There are several options for unassigning a scheme: 

1. From the All Schemes subtab: 

1. Select the target computer or group 

2. Either: 

1. Open the Assign Scheme dialog; or 

2. Select scheme to unassign, and either click the Unassign button or 
double-click on the scheme. 

2. From the Assignments subtab on the Power Management tab: 

1. Select the scheme to be unassigned. 

2. Select the assignment. 

3. Right-click and select Delete Assignment. 

Assigning Through a Group 
A computer can be assigned a scheme in several ways. It can be assigned a scheme directly, 
and it can be assigned through a group to which that computer belongs.  Therefore, a computer 
(or group) may have multiple assignments: 

 Either zero or one direct assignment for each computer or group. On the All Schemes 
subtab, with the computer or group selected, a directly assigned scheme will be marked 
as Assigned. 

 Zero or more assignments through containing groups. When a scheme is assigned to a 
group, the scheme is assigned to all the computers and subgroups within it. On the All 
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Schemes subtab, with a computer or group selected, these assignments will be marked 
as Assigned through a group. 

For example, assume: 

 Computer Bob belongs to group Sales 

 Computer Bob has been directly assigned scheme Maximum savings 

 Group Sales has been assigned a scheme EPA recommended 

The computer Bob has 2 assignments: one direct (Maximum savings) and one through a group 
(EPA recommended). Which of these two schemes is enforced on Bob depends on which one 
has the lowest priority value, as described below. 

This feature of being able to assign through a group provides the flexibility for you to easily 
enforce your power management practices across your organization. You can assign a single 
scheme to your top level groups, and thereby enforce power management across all computers 
in those groups. Or, you can assign a "default" power scheme to all computers through a top-
level group, and then apply a more customized scheme to a subset of those computers by 
assigning a scheme to a specific sub-group. 

Scheme Priority 
Which scheme's settings are applied when a computer has multiple assignments? PwrSmart 
applies the scheme having the lowest priority value. All schemes have a unique priority value, 
hence there is no ambiguity as to which of the several assigned schemes will be applied.  

In the previous example, if the Maximum savings scheme has priority 5 and EPA recommended 
has priority 2, then EPA recommended will be enforced on Bob. 

The applied scheme for a selected computer is marked as Active in the All Schemes subtab. 

Note    At most 1 scheme is active (applied) on a computer at any given time, even if the 
computer has multiple assignments. The scheme with the lowest priority value is the one 
that gets applied. 

Viewing Assignments 
There are three ways to view power scheme assignments. 

1. Assignments for a scheme: Select the  Power Management  tab, then select the 
Assignments subtab. The panel shows all the assignments for the selected scheme. To 
see all assignments, select the All Schemes node in the tree. 

2. Assignments for a computer or group: Select the Managed tab, then select the All 
Schemes subtab. The Assignment State column shows the assignments for the selected 
computer or group. 

3. Power Scheme Assignments report: This report (available via the Reports menu and 
by right-clicking on a group or computer) shows all the assignments. 
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All Schemes tab 

 
The All Schemes subtab under the Managed tab shows all the schemes in the channel and, if a 
target computer or group is selected, will show the assignment and status. It is from this tab that 
you assign schemes to computers and groups. This grid provides summary information about 
each scheme: 

• Assignment State: This column (visible for computers and groups) indicates the current 
assignment status for the selected computer or group. Cells in this column may contain 
several values: 

• Assigned: This value indicates the scheme has been assigned directly to the 
selected target.  

• Assigned through a group: This value indicates the scheme is assigned to the 
selected target through a containing group.  

• <Empty>: If the cell is empty, it means that scheme is not assigned to the 
selected target, either directly or indirectly. 

• Status: This column (visible for computers only) indicates if a scheme is Active (applied) 
on the selected computer. This will always appear on the assigned scheme having lowest 
priority value of all schemes assigned to that computer. However, it may or may not be 
the scheme directly assigned to that computer depending on priority values. 

• The remaining columns summarize the scheme's settings. To get more detail about a 
scheme, right-click on the scheme and select Properties. 

Assign/Unassign button 
When a scheme is selected, use this button to assign or unassign the scheme.  

Tip      A scheme can also be assigned/unassigned by double-clicking on the scheme. 

Right-click option 
By right-clicking, you can open the Power Scheme Properites dialog. 
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Assign Scheme Dialog 

 
Use this dialog to select a power scheme to assign to a particular computer or group.  

This dialog box is displayed when you: 

 press the  icon in the toolbar; 

 select Assign Scheme: 

 from the Power Management menu; 

 by right-clicking on a computer or group on the Managed tab. 

When opened, the current scheme assigned to the target, if any, will be shown in the dropdown 
list. If no scheme is assigned, "No scheme" will be selected. 

Assigning 
To assign a scheme, select the radio button next to the schemes dropdown list. Select a scheme 
from the dropdown list and press OK. This will assign that scheme to the designated target. 

Unassigning 
To un-assign a scheme, select the radio button labelled "No scheme" and press OK. 

5. For more information on assigning power schemes, see the Assigning Power Schemes 
section. 
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Calculating Energy Savings 

 
Using the Energy Savings tab, you can determine how much energy has been saved in a specific 
group or by a specific power scheme. The results include projected annualized savings, as well 
as annual savings per computer, which allows you to compare savings across groups and across 
schemes. 

To calculate savings for a: 

 Computer or group: Select the Managed tab and then the Energy Savings subtab.  

 Power scheme: Select the Power Management tab and then the Energy Savings 
subtab. 

Energy savings is computed based on the energy savings log. The energy savings log is a 
database log containing all occurrences of energy related events (shutdown events, standby 
events, etc.) across all managed machines. You can view this data in the Report | Computer 
Reports | Energy Savings report. Each entry includes the computer's ID, the event type, the off 
and on times, and the scheme active on that computer at that time. 

Setup Panel 

Date Range 
In this area, specify the time range over which you wish to calculate energy savings. The range 
you pick depends on your objective, when schemes were applied, when computers joined the 
group, etc.  

Time span: The time span can be specified in two ways:  

1. Last....: This will extract the specified duration of data going back from mid-day of the 
current day. 
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2. ... starting: This will extract the specified duration of data starting from the date specified 
using the calendar control. 

Note   The database records available for analysis will depend on the settings defined in 
the Channel Properties | Maintenance tab. For example, if in the Maintenance tab 
you specify that only 30 days of data should be retained, then you can only 
calculate savings up to 30 days in the past. 

Calculate Savings: Press this to calculate savings over the specified date range. The Results 
panel will be updated accordingly. The calculation can be done on any of three sources: 

1. A computer: Only energy savings log entries involving the specified computer are 
included in the analysis. 

2. A group: Only energy savings log entries involving computers currently belonging to the 
selected group are included in the analysis. 

Note   Groups can dynamically change their membership. Therefore, take care in 
interpreting the analysis results for highly volatile groups. 

3. A scheme: Only energy savings log entries involving the specified scheme are included in the 
analysis. 

Assumptions: Press this to open the Channel Properties | Power Management tab. This is 
where you specify assumptions such as cost of energy and device wattages. Changing 
the assumptions will cause the Results panel to be refreshed. However, all previously 
generated results (associated with other targets or other date ranges) will be deleted. The 
assumptions influence the energy savings calculations. They define the types of events 
to include and how much energy to associate with each event. 

Results Panel 
This is where the results are shown after pressing the Calculate Results button or changing 
assumptions. 

Actual Savings 
This area displays the actual savings over the time range specified based on the specified 
assumptions.  

Projected Savings 
These are projected annualized savings based on time range reflected in the actual data. For 
example, if the actual time span of the dataset is 30 days, the annualized values will be 
approximately 12 times the actual values. 

In addition, the Annual savings per computer is shown. It is the annualized cost savings divided 
by the number of computers sampled.  

Tip      The annual savings per computer is a normalized value (normalized by time and 
computer count) and hence is the best value to use for comparisons among groups and 
schemes. 

Dataset Analysis 
This area displays information about the data actually sampled.  

 Actual start date: The earliest date found in the sampled energy savings logs. This date 
may be later than the start date specified by the Time span setting in the Setup panel, 
depending on the actual events recorded. 
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 Actual end date: The latest date found in the sampled energy savings logs. This date 
may be earlier than the end date specified by the Time span setting in the Setup panel, 
depending on the actual events recorded. 

 Actual time span: The difference between actual start and end dates. 

 Computers sampled: The actual number of computers in the sampled energy savings 
logs. This may be less than expected for the selected target: 

 Computer: This will be 0 if there are no log entries for that computer over that 
time, either because the computer did not have a scheme assigned, or did not 
have any energy saving events, or those events were filtered out of the results. 

 Group: This will be between 0 and the number of computers currently in the 
group. It may be less than the number of computers in the group if the group 
does not have a scheme assigned and only some of the computers have a 
scheme assigned directly or via another group (see Tip below). 

 Scheme: This will can be any number, depending on how many computers were 
running that scheme and made log entries during the specified time range. 

Tip    Use the Computer Power Schemes Energy Savings Report to determine: 
- For a group, how many computers in that group are actively applying a scheme; 
- For a scheme, how many computers are actively applying that scheme. 
Refer to Energy Savings Reports for more information. 
  

Save and Analyze 
 Export: Exports the analysis to a text file. 

 Compare: Opens the Compare Energy Savings Analyses dialog, which allows you to 
compare 2 different energy savings calculations. 

Print 
 Print: Print the current analysis. 

 Preview: This displays the print preview dialog for the current analysis. You can print 
directly from this dialog. 
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Power Management tab (Channel Properties) 

 
Use the Channel Properties | Power Management tab to define assumptions for energy 
management calculations. 

Note   Changing assumptions will delete all of the current energy savings calculations. 

This dialog box is displayed when you choose File | Channel Properties then click on the Power 
Management tab. It also opens when you select Assumptions from the Power Management 
menu or by pressing the button on the Energy Savings tab. 

General 
• Energy Cost: Enter the cost per kWh to be used in energy savings calculations. This will 

vary by country and region as well as time of year. 

• Currency: Select the currency to use for energy savings calculations. 

• CO2 conversion: Enter the CO2 conversion factor. This is primarily a function of the 
energy source use in your region. For example, natural gas might be 0.185 kg/kWh, while 
industrial coal is 0.330 kg/kWh. The units are kilograms except in the U.S., where the 
units are pounds ("lbs"). 

Wattages 
In this area, you specify the average wattage consumed for desktops and laptops, and, if desired, 
monitors. All desktop computers in your channel will be assumed to have the specified desktop 
wattage, while all laptops are assumed to have the specified laptop wattage. 
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Included estimated savings from monitors: Checking this allows you to incorporate 
into your energy savings calculations an estimate of the energy savings from the monitors 
being turned off in advance of computers entering a standby state. 

For example, if the monitor shuts off after 20 minutes of idle time and the computer enters 
standby after 60 minutes, there is a 40 minutes period where the monitor was off prior to 
the computer entering standby. Assuming the monitor consumes 45 watts, this saves an 
additional: 

(40 min / 60 min) * 45 watts / 1000 = 0.03 kWh 

every time the computer enters a standby state. 

With this option checked, you can enter separate values for the monitor wattage and the 
computer (chassis) wattage. The sum of these two values is the device's total wattage. 

Note    Energy savings when the computer is in a standby or shutdown state always 
includes savings for the monitor in addition to the computer - i.e., the total wattage 
for the device type - regardless of whether this checkbox is checked or not. This 
checkbox concerns only the time when the computer is not yet in a 
standby/shutdown state. 

Included estimated savings from monitors: When this is unchecked, savings from 
monitors being turned off prior to the computer entering standby will not be included in the 
report. When unchecked, the only wattage value you can specify for desktops and laptops 
is total device wattage. 

Event Filtering 
This section defines what events will and will not be included in the energy savings calculations. 
There are two types of events recorded by PwrSmart: shutdown events and standby events. The 
latter events are either hibernate or standby events. 

Included shutdown events: With this option checked, energy savings calculations will 
include shutdown events in addition to standby events in the energy savings calculations. 
This will never decrease but may increase the calculated energy savings. Check this, for 
example, if the schemes include a shutdown event every evening. 

Included shutdown events: With this option cleared, shutdown events will not be 
included in energy savings calculations. Only standby events will be included. Depending 
on the nature of the power schemes defined and your energy management objectives, it 
may not be accurate to include shutdown events in your calculations. 

Note    In addition to this option, PwrSmart automatically filters out all events of short duration 
(less than 4 minutes). Such events do not contribute noticeably to energy savings, and 
often indicate that a machine tried to enter a standby state but was unsuccessful for 
some reason. 
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Comparing Energy Savings 

 
This dialog allows you to compare the energy savings analysis across different groups, schemes, 
or time frames. Every time the Calculate Savings button is pressed, the results are saved for 
use in this dialog. 

Select Results to Compare 
In this panel, select the two results to be compared. Each result is uniquely identified in this 
dropdown by  

 a prefix indicating the type of source (C_ for computer, G_ for group, S_ for scheme), or 
no prefix if the source is a root node (e.g., Managed Computers). 

 the source object (scheme name, group name, etc.).  

 the specified start and end dates in "mmddyy" format. 

The result summary for each selected result is shown beneath the selection. 

Net Savings Comparison 
This panel shows the difference in cost savings and percentage improvement. 

Assumptions 
This panel shows the current assumptions, such as energy cost. 

Note    All saved results are erased when the assumptions are changed. 

Energy Savings Reports 
Energy Savings reports are located on the Reports | Computer Reports menu. They include: 

Computer Power Schemes: Shows the currently active scheme on each computer. Note that 
the active scheme may not be the same as the directly assigned scheme (see Assigning Power 
Schemes for more information). Use the Computer Power Schemes report to determine: 
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 How many computers in a particular group are actively applying a scheme. To do 
this, select the group, right-click, select Reports > Computer Reports > 
Computer Power Schemes. This will show, for each computer in the group, the 
active scheme (or blank, if no scheme is active). By grouping by scheme, you 
can also determine which schemes are active within the group, and how many 
computers in the group have no scheme assigned. 

 How many computers are actively applying a particular scheme. To do this, from 
the Main menu, select Reports > Computer Reports > Computer Power 
Schemes. Then filter by the desired scheme. 

 Energy Savings: The Energy Savings report shows shutdown/suspended events for 
each managed computer over a default period of 30 days. For each event, it shows when 
the event occurred and, depending on the event, shows the wake time and duration of 
the powered down state. 

 Power Scheme Assignments: This shows all the power scheme assignments. 

 Summary of Energy Savings: This shows savings by group. 
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